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Notice

The information in this document is subject to change without prior notice in order to improve 
reliability, design, or function and does not represent a commitment on the part of this company.

In no event will we be liable for direct, indirect, special, incidental, or consequential damages 
arising out of the use or the inability to use the product or documentation, even if advised of the 
possibility of such damages.

Copyright © 1997 - 2010 SoftLab-NSK Ltd.
All Rights Reserved.

No part of this reference manual may be reproduced or transmitted in any form or by any means 
without the prior written permission of this company.

Throughout this manual, we make reference to product names that are trademarks of other 
companies. We are using these names for identification purposes only, with no intention of 
infringement of the trademarks.

FCC Information

FCC ID:	

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules.  These limits are designed to provide reasonable protection 
against harmful interference in a residential installation.  This equipment generates uses and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications.  However, there is no guarantee that 
interference will not occur in a particular installation.  If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the equipment 
off and on, the user is encouraged to try to correct the interference by one or more of the following 
measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.
Consult the dealer or an experienced radio/TV technician for help.

Shielded cables and I/O cards must be used for this equipment to comply with the relevant FCC 
regulations. Changes or modifications not expressly approved in writing by SoftLab-NSK Ltd. may 
void the user’s authority to operate this equipment.

Limited Warranty

Our company warrants this product against defects in materials and workmanship for a period of 
one year from the date of purchase.  During the warranty period, products determined by us to be 
defective in form or function will be repaired or replaced at our option, at no charge.  This warranty 
does not apply if the product has been damaged by accident, abuse, misuse, or as a result of service 
or modification other than by us.

This warranty is in lieu of any other warranty expressed or implied.  In no event shall we be held 
liable for incidental or consequential damages, such as lost revenue or lost business opportunities 
arising from the purchase of this product.
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Introduction

The FDBleepOut program is designed for censoring intolerable 
content from TV programs when broadcasting is being 
implemented. The program requires the FD300 board.

This document contains information on program use, program 
interface and general workflow with it. 
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Program Use Requirements

The FDBleepOut program is included in the ForwardTx Plugins 
Software. Complete the following steps to use the program:

1.	 Install the ForwardT Software of a current version with 
available updates. 

2.	 Install the ForwardTx Plugins Software of a current version 
with available updates.

3.	 Register the FDBleepOut plugin for a corresponding FD300 
board. 

Note: 1. For more information on the ForwardT Software installation, see 
the «ForwardT Software Setup. User’s Guide».
2. For more information on the ForwardTx Plugins registration, see 
the «Plugins Setup. User’s Guide».
3. Software components can be downloaded at: 
http://www.softlab-nsk.com/forward/download.html

http://www.softlab.tv/forward/docs/en_config_fdconfig.pdf
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General Information

1. Working with the Program 
The FDBleepOut program can be used for broadcasting of any 
TV program where communication with TV viewers via the 
telephone in real time occurs (see picture below). In this case 
there is a necessity to control audio line in order to prevent 
intolerable words from being appeared on air. 

The program allows:
to broadcast audio and video data from input lines ●●
on air. Data may be received from one video and two 
audio lines. Lines are selected when the program is 
configuring. Data input/output is made via the FD300 
board; 
to bleep out the sound on a specified audio line and ●●
substitute it by another sound from the specified file 
under operator command.

Broadcast is implemented with a not big time delay (a split of 
second) that can be configured. It allows to bleep out intolerable 
words more precisely. The delay is configured considering 
a time of operator reaction, i.e. the time necessary for the 
operator to recognize intolerable words and bleep them out. 

Bleeping can be implemented by: 
the button located in the main program window (the ●●
Bleep Out button);
the external device plugged to the PC via COM port ●●
assigned when the program is being configured.

Note: The choice of the FD300 board and audio/video lines, configuration of 
video/audio delay and selection of the way of bleeping imlpementation 
are implemented in the configuration window. 

Scheme 1. 
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2. Bleep
Beep sound is a sound from the specified WAV file. Audio clip 
must meet the following requirements:

1.	 The sound at the beginning and at the end of the clip must 
be organized in such way that there won't be any troubles 
on joints when the clip is cycled. 

2.	 The duration of the clip must be not less than 10 sec.

When the operator clicks the Bleep out button a beep sound 
replaces audio signal on the line that is under control (see the 
picture below). 

The start of the bleeping (1) depends on the time of clicking 
the Bleep out button and on the Start offset parameter value. The 
bleep out duration (2) depends on the time of pressing the Bleep 
out button and on the Bleep out duration parameter value. The 
bleep out duration value is equal to the value that is the highest 
among the time of pressing the Bleep out button and the Bleep out 
duration parameter value. 

Scheme 2.
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Program Launch

The program can be launched by ~\Plugins\FDBleepOut\FD-
BleepOut.exe, where ~ denotes a full path to the folder where the 
ForwardT Software is installed. 

The program can be also launched via the Start menu command: 
Programs > ForwardT Software > Plugins > FDBleepOut.

Main (1) and configuration (2) program windows appear when 
the program is launched for the first time. Configure bleep out 
parameters in the Bleep out configuration window. 

When the program is launched again only the main program 
window appears. The program will be configured as it was done 
during previous program session. 

1

2
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Program Interface

1. Main Window
When the program is launched main program window appears. 
The title of the window contains the name of the program 
and the name of the project. The project is a set of settings 
necessary for work. 

2. Mode of Work
There are 2 modes of program work: 

the mode of configuring parameters for work. Bleeping ●●
is disabled in this mode, i.e. the Bleep out button is 
disabled;
the mode of broadcasting. Bleeping is enabled in this ●●
mode, i.e. the Bleep out button is enabled. There is no 
possibility to configure parameters in this mode, the 
Configuration button is disabled.

The program is always launched in configuration mode. The 
Start/Stop button is used to toggle between modes. 

3. Bleep Indicator
The indicator (1) located in the main program window displays 
current state of bleeping, i.e. either it is being implemented or 
not:

green denotes that the ●● Bleep out button is not clicked; 
red denotes that the ●● Bleep out button is pressed. 

2

1

3

4

65

Main window. Control elements:
1 – main program menu; 2 – settings; 3 – start of broadcasting; 4 – bleep; 5 – bleep indicator; 6 – exit 
button.

1
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Configuration and Control of Broadcasting Using Bleeping. 
General Workflow 

General workflow of broadcasting using bleeping is the 
following:

1.	 Plug audio and video devices to the FD300 board and 
configure their parameters in the FDConfiguration program. 

	88 Important: Mute passthrough sound.

2.	 Plug the external device to the computer if bleeping is 
implemented via the external device. 

3.	 Launch the FDBleepOut program and configure its 
parameters. Select the FD300 board, specify WAV file, 
audio line under control and audio line without control. Also 
define bleep out duration, video/audio delay and start offset.

4.	 Implement testing broadcasting using bleeping and check it.

5.	 Start broadcasting when needed. Bleep intolerable words 
out on the line that is under control by clicking the Bleep Out 
button.

The following chapters explain the workflow in more detail.
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Plugging of Devices and Configuring of the FD300 Board

1. General Workflow
Use the FDConfiguration program to configure and to check 
plugging of audio and video devices.

1.	 Launch the FDConfiguration application, either via the 
program shortcut or the Start menu command:  
Programs > ForwardT Software > Board Setup > FD300Configuration 

2.	 Select the FD300 board according to its index (1) from the 
Boards' Indexes list.

3.	 Configure input video line, video output and audio lines via 
the tabs (2). 

4.	 Click OK (3) to apply the settings and to quit the program. 

1

3

2
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2. Configuration of Input Video Line
Complete the following steps to select video source and to 
configure input video line:

1.	 Click the Line A tab (1).

2.	 Select from the Input drop-down list (2) the line where the 
source of video signal is plugged.

3.	 Be sure that a picture is correctly displayed in the Line A view 
area (3). If the picture is displayed correctly then the 
plugging is implemented properly. 

4.	 Configure parameters of the video image by moving the 
sliders (4) when needed.

3. Configuration of Video Output
1.	 Click the Output tab (1) to configure video output. 

2.	 Select necessary mode of video output via the drop-down 
lists (2, 3). The analog video output and the YUV+CVBS 
output signal type in our example. 

1

2

4

3

1

2

3
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4. Configuration of Sound
1.	 Click the Sound tab (1). 

2.	 Then click the Audio Mixer... button (2) to open the window to 
configure audio mixer. 

3.	 Mute the passthrough sound in the FDSoundControl window 
by completing the following steps:

	 1. Tick off all marks (3) enabling input audio lines in the 
group of control over input lines. 

	 2. Check that audio signal is disabled, i.e. the indicators (4) 
should not display the level of the sound.

4.	 Click the Return to FD Config Dialog button (5) to close the  
FDSoundControl window.

1

2

3

4

5
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Configuration of the FDBleepOut Program Settings

1. Program Launch
Launch the FDBleepOut program, e.g. via the Start menu 
command: Programs > ForwardT Software > Plugins > FDBleepOut

The configuration window appears automatically when the 
program is launched for the first time. Click Configuration (1) to 
open the Bleep out configuration window when the program will be 
launched again. 

	 Note: The Configuration button is enabled only in the configuration mode. 

1
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2. Configuration of Settings
Configure program settings in the Bleep Out Configuration 
window:

1.	 Specify a full path to the file with a beep sound (1) by 
clicking the ... button (2). Select necessary file in the 
appeared window. 

2.	 Select the FD300 board considering its index from the drop-
down list (3). №1 in our example. 

3.	 Select video line (4). Line A in our example.

4.	 Select audio line without control (5). Line №2 in our 
example.

5.	 Select audio line under control (6). Line 1L in our example.

6.	 Specify the value of audio/video delay in ms considering real 
time (7), e.g. 1000 ms. This value must be 100 ms high as a 
minimum than the value of the Start Offset parameter.

7.	 Specify the minimal bleep duration (8), e.g. 1000 ms. In this 
case the duration of the beep sound that enters the output 
signal will be at least 1000 ms.

8.	 Specify start offset (9), e.g. 200 ms. In this case the start 
of bleeping the output signal will be shifted back for 200 
ms from the moment of clicking the button. This value is 
assigned by the user.

	 Tip: gg It is recommended to use default values for the Video/audio Delay 
and Start Offset parameters. 

Complete steps 9 and 10 additionally if the external device is 
used for bleeping. If not, pass to the step 11.

1

2

3
4

5
6

7
8

9
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9.	 Select identifier of GPI signal from the Input GPI drop-down 
list (10). 
The identifier of the GPI signal is the following:  
GPI_On_COMN_0_Input or GPI_On_COMN_1_Input, N denotes 
COM port where the external device is plugged. The port 
with the index 1: GPI_On_COM1_0_Input in our example.

10. Select required mode of bleep start selecting among Bleep out 
by state “1” or Bleep out by state “0” (11). 

11.	Click OK (12) to apply settings. 

10
11

12
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Work with Files of the Project 

The program provides a possibility to work with projects, files 
with program settings. The commands that allow to control files 
of configurations are located in the File menu. The names of the 
files with configurations have the FDBleepOutProj extension. 

Complete the following steps to save current configurations:

1.	 Open the File > Save window (1) in the main program 
window. 

2.	 Select necessary folder and type the name of the file (2) in 
the appeared window. Then click Save (3). 

1

2

3
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Control Over Broadcasting and Bleeping

It is recommended to check the work of the beep sound with 
defined settings before the start of broadcasting. 

1.	 Click Start (1) in the main program window to toggle from 
the configuration mode into the broadcasting one.

2.	 Audio and video data are received on the output on selected 
video and audio lines in broadcast mode. In this mode 
bleeping is enabled, i.e. the indicator (2) is green. 

Use the Bleep out button (3) to bleep out the sound. This 
button is located in the main program window. Or use the 
external device plugged to the PC via COM port. 

3.	 Click the Bleep out button to bleep out the sound on the line 
that is under control. In this case the duration of the audio 
clip will be equal the duration specified for the Bleep out 
duration parameter. In our example 1 s.  
When bleeping is being implemented the indicator (4) is red. 

1

2

3

4
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Note: If the button is pressed for some time the duration of beep sound will 
be equal to the duration when the button is pressed. 

	88 Important: The duration of the beep sound is not less than the duration of 
the Bleep out parameter. 

Green GreenRed

Intolerable 
Words

Beep Sound

Initial Sound 

Outcome

Time of Clicking 
the Button 

Color of
Indicator

Bleeping Duration



Useful Links

© SoftLab-NSK

ForwardT Software set: description, download, documentation, solutions
http://www.softlab-nsk.com/forward/index.html

Support 
e-mail: forward@softlab.tv

	 forward@sl.iae.nsk.su

	 forward@softlab-nsk.com

Forums 
http://www.softlab-nsk.com/forum (currently available in Russian only)

Documentation containing additional information:
ForwardT Software Setup;

Plugins Seup;

FDConfiguration: FD300 Board Settings. User's Guide;

FD300Sound Control: Sound Settings.

Translation from
September 21, 2010

http://www.softlab-nsk.com/forum
http://www.softlab-nsk.com/forward/docs/en_fdsoftware_setup.pdf
http://www.softlab.tv/forward/docs/en_config_fdconfig.pdf
http://www.softlab.tv/forward/docs/en_config_fdconfig.pdf
http://www.softlab.tv/forward/docs/en_config_fdconfig.pdf
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